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Introduction

UUDWin is a hassle free Windows 3.1/ Win95 compatible program designed to make it 
easy to quickly extract binary files encoded in a variety of formats commonly used to 
send data through Email and the Internet.    Files are encoded so that binary (8 bit) data
can travel through paths that only support text (7 bit data).    UUDWin supports 
UUENCODE, XXENCODE, BINHEX4, MIME BASE-64, MIME Quoted-Printable and MIME 
Text/Plain encoding formats. It's the easiest to use, most forgiving message decoder 
available for the Windows platform! 

UUDWin needs no special preprocessing of encoded files.    The encoded files may be 
stored in a single file, or in multiple files, and in any order. Pieces are automatically 
sorted. Duplicate parts are ignored. Messages may contain multiple encoded files in 
multiple parts. 

UUDWin uses a relaxed approach to decoding messages, thus it can usually figure out 
what to decode even when missing some header information. You can use it to extract 
files without any message headers at all! 

UUDWin uses a simple Windows style interface, giving you two lists to work with, a list 
of input files, and a list of decoded output files.    You may input data via File Open, Drag
& Drop, Clipboard Paste, Command line arguments, or DDE.    Output filenames are 
automatically detected from the input files. Output files are color coded to show you at 
a glance the status of the decoded file.    Once processed, files may be extracted 
individually, all at once, or you may double-click on the file to launch the associated 
application.    This is handy when dealing with many messages saved from USENET 
newsgroups.

Special features include automatic filename validation/renaming, automatic file 
extension generation, estimated extraction sizes, indented message processing, color 
coded output files, drag & drop support, popup file info, input file monitoring, 
application launching, recursive file decoding, log window, DDE operations, large file, 
and batch support. Of course UUDWin allows other applications to run while it is 
processing. It is multitasking friendly!



Operation

Save messages from Newsgroups or Email in a file or files. Include as much header 
information as possible, such as subjects and part numbers.

STEP 1 - Open the file or files in UUDWin.  
You may open the file(s) manually, double-click on the file in File Manager or Explorer if 
you have saved the file with an extension associated with UUDWin (see Preferences 
dialog ). You may drop the file(s) onto the UUDWin window, or you may paste text or 
files from the Windows Clipboard.    

UUDWIN will now process the files.
As encoded files are detected, they will appear in the Output Files Listbox in black.    
When the input files have been processed, UUDWin will color code the output files. 
Green files are complete. Blue files have a beginning, but may be missing pieces or 
otherwise be incomplete. Gray files are incomplete, and can not be extracted. Red files 
have more parts than expected. Red files are extremely rare since UUDWin usually 
drops duplicate parts automatically. Since this is a Windows 3.1 compatible program, 
filenames are intelligently truncated to DOS compatible lengths. Duplicate filenames 
are renamed using sequential numbers starting with "01", or if the filename is numeric,
a text count starting with "aa" is used.

You can display the status of a file in the Output files listbox by clicking on it with the 
right-mouse button, or by selecting it and then selecting Edit/Properties. (see Popup 
Status ).

STEP 2 - Extract the files.
Now you may choose to extract one or all files to a directory by selecting one or more 
output files and clicking on the Extract button. This brings up the Extract dialog.    

You may also double-click on a file in the Output Files Listbox to launch the application 
associated with the file extension. For instance, double-clicking on a file with the name 
"picture.jpg" will extract the file in the Working directory, launch the application 
registered as a viewer of .jpg files, using "picture.jpg" as an argument.    Once the 
application has been launched, UUDWin will monitor the close of the application, and 
clean up the temporary file.

If any decoding errors occur during the extraction phase, a short beep will alert you to 
additional information contained in the Log Window 

STEP 3
When you are done, exit UUDWin or click on the Clear button to free up memory for 
more files.



Extract dialog

Extract to:
You may specify the destination directory for decoded files in this edit box. If the 
directory does not exist, UUDWin will create it for you, even multilevel 
subdirectories. You may specify as many subdirectories deep as Windows allows. 
UUDWin will prompt you for confirmation before the new directory is created.    You may
also select a previously used directory from the recently used directories drop-down 
list. The special character "*" may be used to specify that the decoded files should be 
written to the directory where the input file(s) are located. You may also specify 
network volume paths such as "\\host\vol\directory"

Files:
You may override the default selections made in the Output Files listbox with these 
controls.
Selected Extracts only the files selected in the Output Files listbox.
All Files Extracts all of the files in the Output Files listbox.
File: You may specify a particular file by entering a name. Wildcard characters 

(?, *) may be used to specify multiple files, case insensitive.

Skip Incomplete Files
When this option is checked, all files displayed in gray or blue in the Output Files listbox
are ignored. Only complete files are extracted.

Overwrite Existing Files
By default, UUDWin will warn you before over writing an existing file. When this option 
is checked, no warnings are issued.

Append All to File
This is a rarely used feature that allows all extracted files to be appended to an existing
file, or to the first file extracted. You must check this box each time you want to use it. 
No warnings will be issued regarding overwriting existing files. To append to an existing
file, make sure the first extracted file has the same name.

Directories and Drives
You may use these controls to specify the destination directory for decoded files.



Preferences dialog

File Types to Associate with UUDWin
By enabling or disabling the checkbox next to an extension, you control what file types 
are associated with UUDWin, and which application gets launched when double-clicking
on a file with one of these extensions.    UUDWin will preserve any existing entries if 
other applications use the same extension. If you wish to restore a previous 
association, just uncheck the extension. Each time the preferences dialog is brought 
up, the system registry is scanned for UUDWin's entries, so the display is always 
accurate, even after other applications have changed them.

Indented Message Detection ( > )
Occasionally you may get a message where all lines are indented with spaces or " >" 
making the message unreadable by other decoding programs. By enabling this option, 
UUDWin will scan each message for indented parts. Allowed indented characters are 
<Space>, "-", and ">". Sometimes this can cause invalid data to be interpreted as an 
encoded files, so that is why this is an option.

Add File Extensions for Recognized Files
Not all decoded files will have the proper extension for Windows. UUDWin can 
recognize many of the most commonly used file types. When this option is enabled 
UUDWin will put what it thinks is the proper extension for a given file. It is not 100% 
accurate though, which is why this is an option. This feature is not available for BINHEX
encoded data.

Find & Decode Plain Text too
UUDWin was designed to extract binary file attachments, but sometimes a text 
message precedes the binary attachment with information. When this option is 
enabled, MIME Text/Plain data is shown in the Output Files listbox as "messageX.txt" 
where X is the message part number. There may be multiple message.txt files listed.

Extract QP (QuotedPrintable) Text with PC End of Line (CR/LF)
Files created on other platforms do not always use the same end of line characters as 
DOS/Windows. When this option is enabled, each end of line in a MIME quoted-printable
encoded file will be extracted using DOS/Windows end of line characters. (CR/LF)

Assume Sorted Message Order (last chance)
This option is used as a last resort. Sometimes messages will be posted where the 
subjects contain useless or incorrect data. UUDWin may be confused by these lines, 
and won't be able to successfully decode multiple part files. When this option is 
checked, UUDWin will ignore the subjects, and process the file assuming that the parts 
are already in sorted order. It is up to you to save the pieces in the correct order. Mime 
encoded messages may still have part number information which is used.

Working Directory
This option allows you to change the Working Directory which is used for temporary 
files and files extracted when launching applications. It defaults to the windows 
temporary directory. It you enter a directory that doesn't exist, it will be created for 
you.
You should make sure this directory is not used to save extracted files!



File Menu

Open
Invokes the File Open dialog .

Extract
Invokes the Extract dialog .

Exit
Exit the application.

Recent files
Open a previously opened file.



Edit Menu

Paste 
Pastes text or files from the Clipboard for processing.    Text pasted from the clipboard is
treated just like any other file. It is scanned for encoded files, and rejected if none are 
found.    Encoded files are added to the Output Files Listbox and the file "Clipboard" is 
added to the input files list.      Files may also be pasted from the clipboard, and are 
added to the input files list like any other file. 

Special processing is done to automatically scan for End Of Line characters, and insert 
them if unusually long lines are encountered in the first 16K of the data. This corrects 
problems pasting data from popular E-Mail programs which remove these characters. 

Delete
Delete the currently selected input file from the Input Files Listbox.    All Output files 
that depend on the deleted file will be removed as well.

Clear
Remove all input files and output files. Same as clicking on the Clear button.

Copy
Extracts the file that has the focus in the Output Files Listbox, and copies it to the 
Clipboard. Note that this file is temporary, and should be used before terminating 
UUDWin, or performing other drag & drop operations.    If the file type is known and 
Windows supports that type as clipboard data, the data will be copied as well. This 
works for types Text, BMP, Wave, and Tiff.

Rename
Brings up the Rename dialog to rename the file that has the focus in the Output Files 
Listbox. This is useful if you don't like the way UUDWin has truncated the filename, or if
the file extension is incorrect.

Remove
Remove all of the selected Output files from the Output Files Listbox. This doesn't 
delete anything, it just removes the entry from the list of files that can be extracted.

Properties
Shows information about the Output file that has the focus. This is an alternative to 
clicking on the file with the right mouse button.



Options Menu

Preferences
Invoke the preferences dialog

Toolbar
Enable or disable the toolbar.

Statusbar
Enable or disable the statusbar.

Log Window
Enable or disable the Log Window.

Sort Files
Enable sorting of files by name. Uncheck this when files are being added automatically 
via Input File Monitoring, to keep the order of the Output Files Listbox from changing.

Always On Top
Makes UUDWin the topmost window.



Help Menu

Contents
Displays the help file table of contents.

Search
Searches the help file for a topic.

Using Help
Displays instructions on how to use Help.

About
Invokes the About dialog which shows program version and copyright information.



Other features

DDE support
UUDWin supports several DDE commands, including opening files via DDE. The format 
of the command is OPEN(``filename``). The service name is the same as the EXE 
name, UUDWIN.

Drag file support
UUDWin allows you to drag a single file from the Output Files listbox to other 
applications that support Drag & Drop operations. When you drag a file to another 
application, UUDWin will temporarily extract the file into the Working Directory Note: 
this file will be deleted when another drag operation is performed or UUDWin 
terminates!    Only a single file is dropped at a time.

Input File monitoring
UUDWin can monitor input files for additions automatically. As another application adds
messages to a file, UUDWin will update the Output Files list with any additional 
encoded files that it finds. To enable this feature, simply double-click on the file in the 
Input Files list. The file will be marked with ">". This feature works great with Internet 
News readers such as WinVn which can append multiple messages to the same file. 
This allows you to view & decode files while downloading!

Recursive file decoding
Sometimes files are encoded multiple times, and must be decoded multiple times to 
get back the original data. When UUDWin encounters a nested file it will alert you when
the file is being decoded. If the buried file has a different file name than the original, 
the data is temporarily added to the Clipboard file and the filename is added to the 
Output Files list, otherwise the extraction continues without interruption.    UUDWin will 
decode up to 4 nested levels at one time.

Missing End of Line characters
When pasting text from the clipboard, the data is scanned for missing end of line 
characters. If unusually long lines are detected within the first 16K, UUDWin will 
attempt to replace the missing characters before processing the data. This function is 
not performed on files opened any other way.

Log Window
The Log window contains the history of activity. Decoding errors and line numbers as 
well as other status information is also shown.

Large file support
UUDWin can quickly and easily decode files containing hundreds of messages and 
encoded files. It has been tested with files of 200 Megs or more! 

Command line arguments
filename(s) 
You may specify a file or files to be processed on the command line. For example, 
invoking the program with "UUDWin c:\mymessage.uue" will launch UUDWin, and have 
it process the file c:\mymessage.uue.

/OutDir=path    or *
Specify the destination directory for extracted files.      The directory must exist, 
otherwise UUDWin will be unable to automatically extract the files specified on the 



command line. When used in conjunction with the /Extract argument, the special 
character "*" may be used to specify that the decoded files should be written to the 
directory where the input file(s) are located.

/Extract
Instructs UUDWin to process input files, extract any output files, and terminate without 
user intervention. Incomplete files are ignored. Files are written to the last used output 
directory if it exists, or to the directory specified with the /Outdir= argument.

/UnInstall
Instructs UUDWin to remove or restore all registry entries and file associations that it 
has modified & delete it's .ini file. Then simply delete the program to remove all traces!



Command Line Arguments
Command line arguments are additional commands that are placed after the program 
name when launching a program. These commands may be stored with an icon or 
shortcut, or may be entered manually.



Working Directory
The Working directory is used to store temporary files when launching an application, 
pasting data from the clipboard, dragging files from the Output Files listbox, or 
extracting BINHEX encoded data. 
You will need enough free disk space to hold any files you extract in the course of 
launching an application or dragging files, plus any clipboard data, plus about 140% 
more than the largest BINHEX file you wish to decode. Usually this is less than 2 
Megabytes.



Frequently Asked Questions

Why are files encoded, and why do I need UUDWin?

Files are encoded into a standard set of text characters that are able to pass through a 
any number of networks and gateways, hopefully unchanged.    Binary files are not able
to pass through these networks unchanged. In addition, files may be split up into 
multiple smaller pieces for easier transmission.    Even though there are well defined 
rules to follow when encoding files, not all programs follow them.    UUDWin was 
designed to handle encoded files that do not strictly follow the rules. UUDWin is able to 
decode files that other programs can not decode, and present them in an it easy to use
way.

How are files encoded?

Generally, binary files are encoded by converting three 8-bit values into four 6-bit 
values. The 6-bit values are used as an index into a standard set of text characters for 
transmission via mail and news. Encoding increases the size of the files by at least 4/3 
or 33%, or more! 

One of the oldest and most popular encoding formats is UUEncoding. Later, a variation 
of that encoding scheme    known as XXEncoding was developed, which tried to get 
around certain limitations of the UUEncoding format. A    more structured mail format 
known as MIME (Multipurpose Internet Mail Extension) was created, which introduced 
Base64    and Quoted-Printable encoding schemes. And finally, a format which was 
made popular on the Apple Macintosh known as Binhex continues to find use on other 
platforms.

What are the .apl files that show up in the Output Files Listbox?

Sometimes when decoding a message, UUDWin will add two files, such as picture.gif 
and picture.apl. The .apl file is the Mime-type application/applefile, which contains data
specific to the Apple Macintosh. It has no purpose on Windows, but is preserved 
anyway.



Binhex

Binhex is a format that was developed to enable Apple Macintosh computers to send 
their files through Mail and the Internet. It maintains Apple's unique file format by 
encoding the filename, time, resource fork and data fork. It is similar to other encoding 
schemes in that it converts three 8-bit values into four 6-bit values, but it also include 
run length compression, which can compensate somewhat for the increase in encoded 
file size.    UUDWin can decode Binhex4 encoded files only. Since UUDWin was designed
for Windows, it automatically decides which part of the Binhex file to decode, either the
resource fork or data fork, whichever is larger. This works most of the time since files 
sent to non Apple users, usually have one fork. Binhex can be used inside of MIME 
encapsulated files, or by itself like UUEncoded files.

Binhex4 uses a the character set:
"!"#$%&'()*+,-012345689@ABCDEFGHIJKLMNPQRSTUVXYZ[`abcdefhijklmpqr"

A Binhex encoded file looks like this:

(This file must be converted with BinHex 4.0)
:#N**6NK&@#j8@&3!9%9B9(4dH(3!!!!!!$`!!!!!A+98D'Pc)'Pc)'%J3QPZ5'9
i0#"PEQ0[C'9N)'ePFh0KCf8Z)%9RB@3X)(P[G5GfC5"NC@0[C'9N)'Pd)3h'k!!
!:



XXEncoding

XXEncoding uses the same rules as UUEncoding, but uses a different character set. It 
does not use the space character in it's encoding scheme which keeps some mailers 
from damaging files.
Three 8-bit values are split into four 6-bit values starting with the most significant bits.  
A    filename and protection mask is provided on the first line which starts with "begin". 
Each line is prefixed with an encoded value indicating the number of decoded bytes in 
each line. For all lines except the last, this should be 45 or "h". The 2nd to last line of 
data can be less than 45 decoded bytes long, followed by the last line of data 
containing 0 bytes. Finally the file ends with only "end" on the line.    
UUDWin will calculate checksums for each line if they are present.

XXEncoding uses the character set:
"+-0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz"

A XXEncoded file looks like this:

begin 644 filename
hJqVt643mNG-tPrIUN4JXPqFdPaQUR4VdQnwUF4xi7rEUSKxp64VVRaIUMKtt
LR4VdPaQUMaJoR4Jm65Fj64FjDko81EdY
+
end



Quoted-Printable

MIME Quoted-Printable encoding differs from the other encoding schemes decoded by 
UUDWin, in that it is used to encode files that largely consist of printable characters. It 
is possible to represent a binary file through the use of hexadecimal representations of 
the binary values. In this case, each encoded binary value is prefixed with =, and then 
followed by its uppercase hexadecimal representation, i.e. =A2.    A file composed only 
of hexadecimal Quoted-Printable characters would be more than 3 times larger than its
unencoded size. The advantage to Quoted-Printable encoding is that it can be used to 
preserve text formatting, and still be readable.

A Quoted-Printable encoded file may look like this:

Message-ID: <852816748@random-pc>
Mime-Version: 1.0
Subject: Messages going nowhere
Content-Type: text/plain; charset=US-ASCII
Content-Transfer-Encoding: Quoted-Printable

>=20
>=20
>This is a message encoded in a quoted-printable format.=0D=0AThe end of line is 
not here=20=
rather it is here!
>It is possible to read though.=
>=20=2D=2D=2D=20



Base64

Three 8-bit values are split into four 6-bit values starting with the most significant bits.  
Lines length must be shorter than 76 characters. In addition. there must be a MIME 
Content-Transfer-Encoding: Base64 header before the start of the encoded data. The 
last line may be padded with `=`. There are a number of other rules concerning MIME 
files that are best covered in detail elsewhere, such as RFC 1521.

Base64 encoding uses the character set:
"`ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789+/"

A MIME Base64 encoded file may look like this:

Message-ID: <852816749@random-pc>
Mime-Version: 1.0
Subject: Check out the attached file!
Content-Type: application/octet-stream; name="myfile"
Content-Transfer-Encoding: base64
Content-Disposition: inline; filename="myfile"

V2h5IGFyZSB5b3UgZGVjb2RpbmcgdGhpcz8gRG9uJ3QgeW91IGhhdmUgYW55dGhpbmcgYmV0
dGVyIHRvIGRvPw0KDQo=

-----



UUEncoding

Three 8-bit values are split into four 6-bit values starting with the most significant bits. 
Then 32 is added to each value to map it into a plain text character.    A    filename and 
protection mask is provided on the first line which starts with "begin". Each line is 
prefixed with an encoded value indicating the number of decoded bytes in each line. 
For all lines except the last, this should be 45 or "M". The 2nd to last line of data can be
less than 45 decoded bytes long, followed by the last line of data containing 0 bytes. 
Finally the file ends with only "end" on the line.    There are many variations of this 
format. Some put checksum characters at the end of each line, some provide 
information on the total number of bytes in the decode file, some provide a checksum 
for the entire file.    Also there are some encoding schemes which follow the uuencoding
rules, but which map the uppercase character to lowercase.
UUDWin will calculate checksums for each line if they are present. It will also decode all
standard and nonstandard variations I've seen, including files encoded with lowercase 
characters!

UUEncoding uses the character set:
"`!\"#$%&'()*+,-./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_"

A UUEncoded file looks like this:

begin 644 filename
M5VAY(&%R92!Y;W4@9&5C;V1I;F<@=&AI<S\@1&]N)W0@>6]U(&AA=F4@86YY
7=&AI;F<@8F5T=&5R('1O(&1O/PT*#0H`
`
end



Known Problems

Many Win3.1 applications will not copy more than 64K of text to the clipboard. UUDWin 
will read as much data as is available, however the decoded file will usually be short. 
Use file save/load or drag & drop with these applications instead.

When there are multiple files encoded in multiple parts, the status color (complete or 
incomplete) of an individual file is not shown. Rather it is the status of all parts. An 
individual file may be displayed in blue(incomplete) when in fact it is complete.

When launching an application from UUDWin, UUDWin will extract the file into the 
working directory. When the application terminates, UUDWin will delete the file. If the 
launched application launches another application, UUDWin may prematurely delete 
the file. For example, with Win95, if a .txt file is extracted which is too large for 
Notepad, Wordpad will not be able to find it. Simply extract the file, or drag it to the 
application.

UUDWin does not detect the type of Microsoft application when decoding newer 
MSWord, MSExcel, or MSPowerPoint files, only that it is one of these types. The file 
extension will not be changed if there is one, otherwise it will default to ".doc".



Popup Status

When files are displayed in the Output files listbox, you can get additional information 
about a file by clicking on it with the right mouse button. This is especially useful for 
incomplete (blue) files. The following information is displayed:

Subject:
The subject of the message or messages used to group parts. You can see the original 
filename before truncation to 8.3 compatible lengths.

Filename:
The name and path of the input file.

Encoding:
The type of encoding used, such as Base64.

Message Type:
The recognized file format of the file such as jpg or gif, or "Unknown" if it can not be 
determined.

Parts:
The number of pieces found and expected. -1 for "unknown".

Missing Parts:
The list of missing pieces (if any).

Starts & Ends: 
This is used to determine if a file is complete. There should be at most one more end 
than start.

Original filename:
When the original filename differs from the filename highlighted in the Output Files 
listbox, it will be shown here.



File Open dialog

Select one or more files to be processed by UUDWin.    UUDWin keeps track of the files 
that have been recently opened. Select these from the bottom of the File menu.

File name 
Select or type the name of the file you want to open. This box lists files with the 
filename extension selected in the List Files Of Type box. Multiple files may be specified
by using a space between each filename.

List Files Of Type
Selects the type of files you wish to see in the File Name list. UUDWin will remember 
your last selection.

Encoded Files (*.UU, *.UUE, *.XXE, *.MM, *.B64 *.HQX)
List all of the files in the directory with usual encoded file extensions.

All Files (*.*)
List all of the files in the directory.

Common Files (*.TXT, *.HTM)
List all of the files in the directory with these common file extensions.

UUEncoded Files (*.UU, *.UUE)
List all of the files in the directory with UUencoded file extensions.

MIME Files (*.MM, *.B64)
List all of the files in the directory with MIME encoded file extensions.

XXEncoded Files (*.XXE)
List all of the files in the directory with XXencoded file extensions.

Binhex Encoded Files (*.HQX)
List all of the files in the directory with Binhex encoded file extensions.

Drives
Select the drive that contains the file(s) you want to open.
Directories
Select the directory that contains the file(s) you want to open.



Distribution

Permission to use and distribute UUDWin for any purpose and without fee is hereby 
granted, provided that you don't profit from UUDWin directly. This software may be 
distributed as long as this notice remains intact and the software is not altered in any 
way. This software may not be sold for profit.



Disclaimer

This software (UUDWin) is provided "as is" without any warranty, expressed or implied. 
If you use this software, you do so at your own risk. Neither the author of UUDWin 
(Mark Spankus) nor any other party will accept responsibility for any data loss, 
equipment damage, or other unforeseen consequences or damages that arise as a 
result of the use or misuse of this software.



Recognized file types
Recognized file type include:

Bitmap formats: 
BMP (Windows), GIF, JPG (JPEG), PCX, PIC (Lotus), PNG, TIF (Tiff)

Audio formats: 
AIF, AU, MID (MIDI), RA (Real Audio), VOC, WAV

Video formats: 
AVI, MOV (Quicktime), MPEG

Archive formats: 
ARJ, LHA (& LZH), RAR, ZIP, ZOO

Other formats: 
EPS (Postscript), EXE (Executable), HLP (WinHelp),    PDF (Acrobat), WRI (MSWrite)
Microsoft Apps - DOC (Word), PPT (PowerPoint),    XLS (Excel)



Input files list
The list of files that have been processed and contain encoded data. Files may contain 
single or multiple messages, and may be sorted in any order.



Clipboard file
A special file that contains the data pasted from the clipboard, or other temporary data.
This file is automatically deleted when the program terminates.



Monitored files
A file that is marked with > in the Input Files List, is automatically monitored for any 
additional data. This allows another program (such as a News Reader) to write data to a
file, and have UUDWin automatically process the file, updating the Output Files Listbox.
Double-click on the file to toggle monitoring. If a monitored file gets smaller or is 
deleted, it will be removed from the Input Files list, and all Output Files it contained will 
be removed.



Output files list
The list of encoded files found. Complete files are shown in green. You may double-click
on a file to view it, or right-click on a file to see additional information. You can also 
drag a file to another application.



Incomplete files
Incomplete files are files that are thought to be missing one or more parts, or are part 
of a group of files that are missing one or more parts. Incomplete files are shown in 
blue. Use the right mouse button to click on a file to find out more information. 
Occasionally a file is marked as incomplete when it is actually complete.



Missing-start files
Files that are listed in gray, can not be extracted because they are missing the start of 
the file. Either there is no data to decode, or the message part containing the start of 
encoded data is missing.



Selected Output files
Files that are selected in green or blue, are marked for extraction or other operations 
such as rename or remove.



Extract button
Brings up the Extract Dialog to decode one or all of the listed Output files.



Clear button
Remove all of the Input files, which removes all of the Output files. The input files are 
not deleted, they are simply closed.



Paste button
Pastes text or files from the clipboard and adds any files encountered to the Output Files 
listbox.



Copy
Extracts the selected output file, and copies the file (name) to the clipboard. Also copies 
known windows types TEXT, BMP, WAVE, and TIF as data.



Status bar
Shows information about the current operation, or menu help. When processing Input 
files, or extracting Output files, this shows the percent complete as a bar graph.



Open button
Use this button to invoke the File Open dialog.



Exit button
Use this button to terminate UUDWin, and remove any temporary files.



About button
Use this button to invoke the About dialog. Which shows program version and copyright
information.



Estimated size
Shows the calculated size of the decoded file. This is an estimate only, and is usually 
accurate to within 1 or 2% of the actual file size.



Log Window

This is a window that shows the history of file activity, and any errors that are 
encountered when extracting files. Decoding errors are shown with the line number of 
the error.
The Log Window is enabled from the Options Menu.

Note this window differs from most dialogs in that it can be resized, and remembers its 
position between uses. Also, information is written to the Log Window even if it is not 
enabled. When the Log fills up, the oldest information is discarded. The newest 
information is at the bottom of the list.    

The Log Window information is cleared when the Clear button is pressed either in the 
Main dialog or the Log Window.



Menu Items

The File Menu
The Edit Menu
The Options Menu
The Help Menu



No data found

UUDWin scanned the file, but was unable to find any encoded files.
This may be because the encoded file was indented and Indented Message Detection 
( > ) was not enabled, see Preferences dialog.

Perhaps the file did not contain the normal headers used to find encoded data.
Make sure you have saved messages with as much information as possible, such as 
Subjects and    part numbers.

Perhaps the End Of Line characters (Carriage Return and/or Line Feed) were lost if the 
data was pasted from another application.
Save the data to a file instead of copying the data to the clipboard.



No message start

The file can not be extracted because the first piece was not found.

UUDWin requires that the first part of an encoded file be present in order to extract the 
file. Files that can not be extracted are shown in gray in the Output Files Listbox.

Sometimes messages without any encoded data will be shown in gray in the Output 
Files Listbox. These files are used as place holders for additional message parts that 
may be found later. UUDWin can mistakenly add a file when the message subject 
contains a message part number and filename. For example "A new file    myfile.zip part
0 of 3" will be listed in gray as myfile.zip.

To find out more about the file, click on it with the right mouse button. This will show 
you the Popup Status.



Directory Invalid

The directory path entered is invalid. Enter a valid directory path.



Directory is Read-Only

The specified directory does not have write access.    UUDWin requires that the directory 
have read/write access. Choose a directory with read/write access.



Recursively Encoded Files

A recursively encoded file is a file that has been encoded more than once. Sometimes 
this happens when an encoded file is sent by a mail program that doesn't realize the 
file is encoded, and encodes it again.

UUDWin will scan a newly decoded file for encoded data automatically when the 
decoded file contains only text. When recursively encoded files are found, you can 
choose to have the file fully decoded.



Filenames Differ

When processing a recursively encoded file, UUDWin found filenames which differ from 
the decoded filename. Since an associated application may depend on the filename, 
the newly discovered files are appended to the Clipboard file instead of being fully 
decoded. You may select the new files in the Output File Listbox for extraction.



Multiple Files Discovered

When decoding a recursively encoded file, multiple files were encountered. Since only a
single file was expected when starting the decoding process, the newly discovered files
are appended to the Clipboard file instead of being fully decoded. You may select the 
new files in the Output Files Listbox for extraction.



Verify Creation of New Directory

The specified directory does not exist. UUDWin will try to create this directory for you if 
you respond to the dialog with "OK".



Wait for Launched Application

When you double-click on a complete file in the Output Files Listbox, UUDWin will extract the
file into the working directory and launch the application associated with the file type. When 
the application terminates, the extracted file is removed to keep from filling your disk drive. 

UUDWin can monitor only one launched application at a time.    If you attempt to launch a 
second application, UUDWin will ask you if you want to continue to wait for the first 
application.    If you select no (meaning you don't wish to continue waiting), UUDWin will try 
to remove the extracted file associated with the first application. However this may silently 
fail if the application is using the file. In this case you will need to manually remove the file 
from the working directory at a later time.



DDE support

DDE (Dynamic Data Exchange) is a simple mechanism for sending data or commands 
between running programs. UUDWin supports several DDE Execute commands, which allows
another program to control UUDWin, effectively turning it into a decoding engine. When 
running automated, UUDWin will not show non critical error message boxes

Supported DDE operations are:
Open - [open("filename")]    Loads and processes the specified file.
Extract - [extract("path")] Extracts all of the complete files into the specified 
directory.
Clear - [clear] Removes all files and resets UUDWin
Purge - [purge] Removes all complete and partially complete output 
files.
Quit - [quit] Terminates UUDWin.

DDE commands should be sent when linked to the "System" topic. 
The service name is the same as the EXE name, "UUDWin", and may be found in the registry
under \\HKEY_CLASES_ROOT\uudwin\shell\open\ddeexec\application.
If UUDWin is busy processing a command, it will return DDE_FBUSY to any additional DDE 
commands. 




